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This is Part 2 of the IMS Enterprise Suite for Explorer Hands-on-lab. You will create
the metadata required to access an IMS database and see how this can maintained in
a centralized area called the IMS Catalog. The IMS Catalog was introduced as part of
IMS version 12. Once the metadata is available in the IMS Catalog, the IMS universal
drivers can be configured with a connection to access the database.

If you did not participate in the Part 1 hands-on-lab then please reference pages 2 to 3 of this
document to understand the environment.

IMS Enterprise Suite Explorer for Development
In this part of the lab, the IMS Explorer is used to create the PSB extended source by
parsing the IMS PART Database PSB and DBD sources.

Note that in your workstation environments, the IMS Explorer is a plug-in to Rational
Developer for System z.

1. Start Rational Developer for System z
Click on Start > All Programs > IBM Software Delivery Platform > IBM Rational
Developer for System z with Java V8.0.3 > IBM Rational Developer For System z
with Java
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You may be prompted to select a workspace. A workspace is a directory that stores all of
the files for the projects. You can select your own directory, e.g., C:share\explorerlab\work
or take the default directory.



& Works pace Launcher

Select a workspace

IBM Rational Developer For System z with Java stores your projects in a Folder called a workspace.,

Choose a workspace Folder o use For this session.

X

Workspace: | Crisharetlexplorerlablwork]

v| [ Browse, ..

[ Use this as the default and do not ask again

When Explorer startup is complete, you may be shown the Welcome Screen.
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If so, close the Welcome page (x the tab at the top of the screen on the left).

Close the Welcome page.

2.

ject” as a choice then click on File > New > Other and open the IMS folder).
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Enter a Project Name, e.g., Lab2PnnSAMO09 where nn is your team number

2 New IMS Explorer Project |Z|@@

Create a new IMS Explorer project —
Enter a project name,
U
*Praject name: | | ahzpnnsAMog
3
\?,' < Back ” Mext = ] [ Einish l ’ Cancel ]

Click Next.

On the Import IMS Resources (DBDs and PSBs) you can use Local file systems
when the source files have been downloaded to your workstation. You can select
z/OS system and connect to your z/OS system where your DBD/PSB is stored. For
IMS 12 with Catalog function enabled you can obtain the Metadata. If you partici-
pated in Part 1 of the hands-on-lab then this set of instructions are similar to what

you did earlier.

For this initial part of the lab we will assume that the metadata to access the IMS
database does not yet exist in the IMS Catalog. To begin, use a connection to the
z/OS system and download source from z/OS to create the Metadata.

Select z/OS system to obtain the source

2 New IMS Explorer Project |:|@@

Select an Import Source

Import From:
() Local file system

Prerequisite; Before you can import IMS resources, you musk copy the files Fram
wour /03 environment to vour local workstation by using FTP.

Prerequisite: Before wou can import IMS resources, yvou must have access to a PDS
File in wour 2/05 swstem.

(C)IMS cakalog

Prerequisite: Before you can import IMS resources From an IMS catalog-enabled
syskem, you must create an IMS connection profile For that system.
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S New IMS Explorer Project |:|@@

Select Resources from z/0S System
N\

=
PSE {program specification block)
PSBs ko import:
PSE MName Path | Add PSB,.,
¢ | >

DBD (database description)
DEDs ko import:

@j Firish ] [ Cancel

Select the Add PSB button.

3. You will be asked to provide the z/OS connection information.
the previous lab, you will see a “No z/OS connection.” If you attended the previous
lab and used this same workspace then you may see an existing connection and

you may proceed to instruction 4.

If you do not already have a connection then click on the “No z/OS connection” to

open the Connections box.

If you did not attend

L4 Import IM5 Resources (DBDs and PSBs) |:|@E

Connect to z/0S System and Select Resources to Import

Syskem z connection:  ® ~ Mo 2[0S connection

Browse the remote z/03 system to select DEDs and PSEs to import from a PDS or Sequential Data Set, ﬁfg

High-lewel qualifier:

Cancel




select New.
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Help o]
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M5 Explorer
InstallfUpdate
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(m 1avaEE [ 5 — [Restore Qefaults] [ Apply ] v
@j [ [a]4 ] [ Cancel ]

In the Name field enter PnnSAMO09 where nn is your team number
In the Host name field enter zserveros.demos.ibm.com
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-
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Click Apply and then OK to return to the Connect to z/OS System and Select Re-
source to Import box which now has your connection name.



4. To establish a connection click the orange box . and choose the connection
you created to open the System z —FTP New Credentials box

L4 Import IMS Resources [DBDs and PSBs) |:||E|[g|

Connect to z/0S System and Select Resources to Import
EBrowse the remote 2/035 system to select DEDs and PSEs to impork from a PDS or Sequential Data Set. ﬁff

High-level qualifier: | |

@

"4 Signon

System z - FTP: New Credentials

%UEJ =

User 1D | MPOTIE |
Password: | sesvens |
[ 5ave passward

i Saved passwords are stored on your computer in a file that is
= difficult, but not impossible, for an intruder to read.

@ [ Ok, H Cancel ]

In the userid field enter IMPOTxx where xx is your team number.
In the password field enter IBMO7POT.
Click OK to establish the connection.

5. You are now ready to retrieve your IMS resources.



-4 Import IMS Resources (DBDs and PSBs) |:|®

Connect to z/05 System and Select Resources to Import |
Browse the remote 2/05 syskem to seleck DEDs and PSEs to import from a POS or Sequential Data Set, m{g ]
L8]

System 2 connection: @+ P1754MO9

High-level qualifier: | IM3.%12R1.SCFSISRC | {0}

@

Change the High-Level qualifier field to IMS.V12R1.SDFSISRC and hit Enter on your
PC keyboard.

<2 Import IMS Resources (DBDs and PSBs) |Z|E]

Connect to z/0S System and Select Resources to Import &

e T

Browse the remote 2/035 syskem to select DEDs and PSEs to impart from a PDS or Sequential Data Set, ﬁf“g 1

Swsktem z connection: @+ P175AMO9

High-level qualifier: | {M5.¥12R 1, 5DFSISAC | (219
[E] arcHicL »
CAICL =
s

CSLOCO00
CSLDINND
CSLODEM
C5LoIo00
C5LOM

[E csLrIoon

£

@ Einish

Scroll down the list and select your PnnSAMO09 PSB where nnis your team number.



54 Import IMS Resources (DBDs and PSBs)

Connect to z/0S System and Select Resources to Import =

Browse the remate z/05 system ko seleck DEDs and PSEs ko impott from a PDS or Sequential Data Set. fg ]
@, =]

Systern z connection: @+ PnnSAaMO09

High-level qualifier: | [M5.%12R1.5DFSISRC | 219

[E] Po1samog ~
|E pozsamog
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PO45AMOS
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[E] poesamoe
PO7SAMOY
[B] pogsamog
[E] pogsamog v

©

Click Finish to activate the parsing of the PSB and DBD.

Note you will be prompted to add the DBD DI21PART. Select the ADD DBD button.
Scroll through the list and select DI21PART.

@ New IMS Explorer Project _|@®

Select Resources from z/0S System
o
=

P3E {program specification block)

PSBs ko impart:
PSE Name Path | AddPsE.. -
P15SAMOY IMS.¥12R1,SDFSISRC.P155AMD2
Delete PSB
( ' . -2 Import IMS Resources (DBDs and PSBs) E]
=

Connect to z/0S System and Select Resources to Import |

e i tie ) Browse the remate z/05 system ko select DEDs and PSEBs to import fram a PD'S or Sequential Data Set. # ]
DBDs toimpork: @ |

DED Name Referencing PSE or DED Path Add DEDn..

System 2 connection: @ = PnnSAMOS

High-lewvel qualifier: ! IM3.%12R1,.5DFSISRC | (219
n i 2 || pFszLDSY »
= = [Ell oFszLosw
& DBDs to import For the selected PSEs or DEDs: @ DFS0033C

LFS30CEL

This list shows any DEDs that you still need to impart based on your

selected PSBs or DEDs, because a PSE or a DBD that you added T

references that DED. [E] psperROC
DBD MName Referencing PSE or DED D3PUPICL -
DIZIPART P1SSAMOS @ DO0SPART

[E] HwsCF00 M

Click FINISH.




After parsing completes your project is created.

6. In the Project Explorer box, click the + to open your Lab2PnnSAMO9 project and
navigate to the DBD folder.

To open the basic view double click on DI21PART. You will see a view of DI21PART.

2 ms Explorer - PnnSAMO9/DBD/DI21PART. dbd - IBM Rational Developer for System z with Java

File Edit MNavigate Search Project IMSExplorer Run Window Help
N HRR -4 i = G [@usesow | >
[ Project Explorer 52 = 0| § piziparT.dbd E3 = =
[ <§> . = |||l Project: PnnSAMOS || Database name: DIZIPART || Database access bype: (HISAM,WSAM) ||
= -t
= — A~
5 W Wie:
([ IM5 Universal Drivers Metadata
[#-E%, JRE Syskem Library [jdk]
2] I; imsudb. jar - C:\Pragram Files\IBMIE
=G oeo = PARTRODT
[ DI2LPART.dbd Length: S0 bytes
[# Eﬁ DBD Source b —
3 5 L PARTKEY
Y
@ Data Source 54 T Mavigator = ‘ | |
= % [ e
g W |89 md | B = STANINFO = STOKSTAT
= (&> Database Connections Length: 85 bytes Length: 160 bytes
&4 BIRT Classic Models Sample Database 2 STANKEY 7] STOCKEY
&2 Derby Sample Connection - -
== ODA Data Sources
(= Classic Models Inc. Sample Database
(= Flat File Data Source — CYCCOUNT — BACKORDR
(= JDBC Data Source Length: 25 bytes Length: 75 bytes
(= Weh Services Data Saurce E CYCLKEY E BACKKEY
[ %ML Data Source - Y o
< | ¥
[ DI21PART
< Y = Properties &2 Cf‘ Error Log | [ Problems :_”l =] 1}:5 =8
E Fetching children of DHET612.*

The Manage Fields function is used to add more fields to the segment since only the

key fields are defined. Right click on PARTROOT and select Import COBOL or PL/I
Structures.

2 M5 Explorer, - PnnSAM09/DBD/DI21PART. dbd - IBM Rational Developer for System z with Java

File Edt Mavigste Search Project IMSExplorer Run Window Help
- i 44 20 @ msexporer |
[ Project Explorer 22 = O || & prz1parT.dbd &2 = |
£ & 2 ||l Project: PhnSAM9 || Database neme: DIZIPART || Dakahase access type: (HISAMYSAM) ]
E
= =m— ~
G G2 IMS Universal Drivers Metadata L
B B JRE System Library [ick]
[ o imsudbjar - C:iProgram Filest 1M
=& o = PARTR - >
" DIz1PART dbd Length: |8 or PLY
4% DBD Source ~ — . Add, Edit, or Remove Fields
4 2 |6 PARTK] e ), i, or Remave seament Maps
B Data source 52 %5 Mavigator| = O *——F & EdiEncading and Remarks
= visuslize As »
= & (s <
BE M L)< ik B = STANINFD -
(= [ Datahase Connections Length: 85 bytes
£ BIRT Classic Models Sample Database L STANKEY
4 Derby sample Connection s = E‘ Reset Layaut
= ODA Data Saurces [ Show Properties
(= Classic Madels Inc. Sample Database = Prink
=
(= Flat File Dat Source I BYCCA [ save as
(= IDBC Data Source Length:
(= Weh Services Data Source T CYoLkE Run As 3 |
(& XML Data Source ———— Debugas » @
T profile as » 3
i/ DI21PART Validate
Software Analyzer »
< | 3| El Properties 32 @ JEmorlog [Z Probler  Team y B = =l
= Compare With v 1
Replace With & |




The Import Data Structures box opens. You will need to import the COBOL structures. The
copybook was previously downloaded to your workstation. Select the Browse button and
look for the following directory C\share\anaheim2012\lab\source.

Select COOSAMO09 and click Open.
Select File FX

Lok ir: ‘[’j‘) s0UICE V| Q2 |-

Y ] consamns.cpy
{ :} |1#] psnosPaRT.dhd

MyFecent | ||4]PinSAMOg psb
Documents

Desktop

My Documents

98

ty Computer

File name: | CO0SAMOT.cpy M ‘ [ Open ]

My Network Files of type: ! B - ‘ [ Cancel ]

Use the Drop down list to specify the structure for the PARTROOT segment.

L4 Import

Import Data Structures =
=
Import COBCL or PLYT data structures (from copybooks or includes) From the local file system, ‘T\:‘
# Source Folder: !C:\share\anahemeDl2'|,Iab'|,source V|
# Data structure file: |cggs,q|\qug,cpy v| [ Browse... ]

# Data skruckure name: F'F\

- | # Segment name! | PARTROOT -
Map narne: |Unmapped Fields ~ | Case name:

The imported data structures in the Following table are added as new Fields to the associated segment or
to the associated map case within the segment when you click Finish,

Segment Mame Data Struckure,..  Map Name Case Mame Daka Struckure, .,

Select Add button.
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Click Finish to complete the import process.
The PARTROOT segment (table) will now have all the fields (columns).

& IMS Explorer - PanSAMO9/DBD/DI21PART. dbd - IBM Rational Developer for System z with Java FBEX
File Edt Navigate Search Project IMSExplorer Run Window Help
i HER:iArid i Gl El@uscoe ) =
) Project Explorer 52 = O *0iziPaRT.dbd £ = ]
= <§> % || Project: PinsaM0d || Database niame: DIZIPART || Database access typer (HISAM,YSAM) ||
] -

-G PrnsiDg A View:

%128 M5 Uiniversal Drivers Metadata
[ TR Sustem | brary [idk]

o :\Program FilesiBn
= PARTRODT
 DiztPART dbd Length: 50 bytes
% 23 08D S0urce ™ =
3 5 FLPERT_NO_EDIT
- = = T
DataSource EJ ‘G Navigator g S REIECT_CODE
o5 %[5 % udlB” :

(= Database Cannections

[ BIRT Classic Models Sample Database = STANINFO = STOKSTAT

{2 Derby Sample Connection Length: 85 bytes Length: 160 bytes
[ ODA Data Sources = =

- STANKEY - STOCKEY

(= Classic Models Inc, Sample Database S = < =

(2 Flat File Data Source

(= IDBC Data Source

(& Web Services Data Source = CYCCOUNT = BACKORDR

(& ML Data Saurce Length: 25 bytes Length: 75 bytes @

< 3
¥ DIz1PART

< 5| Dl roperties 28 ©EmorLog 21 problems fual ‘EI »E~=0
S Fetching children of DHET&12,*

Repeat the above process for the other segments.

This completes the field definitions. Use Ctrl-S to save the changes or just use the x
tab to close the view. Follow the path Lab2PnnSAM09> DBD Source >Generated
Source> IMS Catalog-enabled DBD source > DI21PART and double-click to view the
updates to the DBD source.

@ IMS Explorer - lah2P1 9SAMO/DBD Source/Generated Source/IMS catalog-enabled DBD source filesMI121PART - 1B... [T |[F) (5]
Ele Edit Mavigate 3Search Project Run  window Help

1w~ =i % ¥ L I ] : & X é b5 el EE’IQIMSEprorar \
[ Project Explorer 22 5 % 2 Y ° 0| ¢ oziparr.ded [ DI21PART &2 =" (]
= E labZP125AMO2 L I LED NAME=DIZ1PLRT, A
[*-(# IMS Universal Drivers Metadata ACCESS= (HISAM, VSLN) ,
[ IRE Syskem Library [idk] PASSUD=NO,
=] __ imsudb.jar - C:'\Program Files\[EM\SDPYiD DATEEXIT=NO,
- oBo ENCODTHG=Cpi047 _
= % DED Source DATASET DD1=DIZ1FPART,
= Eﬁ Generated Source DEVICE=3380,
(== M3 catalog-enabled DED source Files OVFLU=DIZ1PARO,
|=| DI2IPART ~ SIZE=(2048,2048),
< B . RECORD= (678, 673)
Data Source Explorer &2 = et g;?iR;ii;iigI;ARTROOT,
EG W (s @i B~ PARENT=0,
[z = Database Connections ~ BaIESSS0,
4 BIRT Classic Models Sample Database FREQ=250
63 Derby Sampls Connection FIELD NAME= (PARTKEY,SEQ,U), 3
= TYTROMAT MAMT=0A0T MM FRTT
IM5 DB part < s
(== ODA Data Sources
(= Classic Models Inc. Sample Database = propert "-_-_“ Errar L [f\_\ Proble | 51 SQLRe JJE Remate }_IE Remate &4 =
(= Flat File Data Source |_L‘_!,—_I 2
(= IDBC Data Source v —
e ‘wiritable Insert i il

Notice the extension information such as ENCODING, EXTERNALNAME, etc.

12



This completes the building of the DBD macros source definitions for creating the Catalog
metadata.

Once the metadata has been created, the next step is to send the source back up to the Sys-
tem z environment so that the PSB/DBD and ACB gen jobs can be run. For IMS V12 Catalog
environments, a new ACBGEN utility (ACB Generation and Catalog Populate utility
DFS3UACB) is used to generate the ACB member and corresponding metadata records in the
IMS Catalog.

NOTE: For this lab these jobs have already been submitted. The IMS Catalog for IMSB on
zserveros.demos.ibm.com has been updated so that you can use it in the next section.

7. You will now use the Data Store Explorer (DSE) in IMS Explorer to access the IMS PART
database using the metadata from the IMS Catalog.
If you already have the Data Source Explorer box open at the bottom of your RDz window
then you can skip the following instructions.
If you do not have the Data Source Explorer box then click on the Window tab at
the top of the RDz tool and follow the following: Show View > Other. In the Show
View box, click + Data Management, select Data Source Explorer and click OK.

& IMS Explorer - IBM Rational Developer for System z with Java Q[ﬁ|§| © Show View |_|@®
File Edit Mavigate Search Project Fun RENGGETE Help e

1 ] 52 i g v MewWindow (D M5 Explorer | 7
i ata
Open Perspective » [ COBOL -
L Praject Explarer 53 Shiow Wiew @ Error Log Alb4 = Caode Coverage
= <':==b | Customize Perspective... ‘o5 Mavigator = Cvys
=05+ Prnsamog Save Perspective As... S: Cutline ik == Data Management
(=22 M L | Dri Metadat Reset Perspective. .. i _ K
% niversal Drivers Metadata o P . L Project Explorer 5. Data Project Explorer
= pissam0a 08 erspective =l Properties
[ERORF 1552M02Dstshas Close All Perspectives I Data Source Explorer
(9 P155AMOTDAt Lo K i €~ Execution Plan
=) @a JRE Syskem Library [jdk] é@ Madel Repart
(oo imsudb. jar - C:\Program FilesiTEM) Preferences fa— S0 Result
=47 pep = 501 Resulks
[ DIz1panT.dbd (= Debug
- (42 DBD Source (= Enkerprise Service Tools
=
5 % iz (= Fault Analyzer
By Q]} PSE Source & "
(1= SCLMConfigPraject File Manager
< N = Help
e = (= 1BM SCLM Developer Toolkit
Eﬂ Data Source Ex &2 ‘5 Mavigator 8
el = (= Java w
S-S R T
(= Database Connections — =] Prop 52 & Error | [2 Probl =
E4 p10T rlaccic Madale Samnla Nakshaca —
: 0* [J] p1Ssami9.P1SSAMISDatabaseView java - PRnSAMOS/IMS Universal Drivers Metadata & ] [ =
- Fetching children of DNETE12.*
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In the Data Source Explorer window, right-click the Database Connections folder, and

click New.

2 IMs Explorer - IBM Rational Developer for System z with Java

=g} Prnsamog
= IM3 Universal Drivers Metadata
=3 p15samig
= m P1554M09Databaseview. java
© P1554MO9Databasetiew
B JRE Syskem Library [jdk]
-l i ihy iar < A Brnneamm Filest TRAM SOk

ﬁ Data Source Explorer 53 B Mavigaktor

(= el e
E_ﬂ BIRT Classic Models Sample Dakabase
&4 Derby Sample Connection
[=-[Z= ODA Data Sources
(= Classic Madels Inc. Sample Database
(== Flat Filz Data Source
(= JDBC Data Source
(== web Services Data Source
(= ®ML Data Source

1 = Database Connections

© Fetching children of DMETE12,*

&~

-

File Edit Mavigate Search Projectk Run  Window Help
[ty . .
I e : % S 4
* =l
. —+,
[T Project Explorer 52 =l <;=='g> -

=[]

>

-

==

55 (5 S el BT

ﬁ |\‘) IMS Explorer | 2%
PE Crata
=
9_7 E l:gA B £ = H

The New Connections box opens up. Select IMS as the database manager and the driver
name IMS Universal JDBC Driver as the JDBC driver.

& New Connection

Connection Parameters

@ Vou must specfy & valid port number for your databass server,

Cannection identification

Use default naming conwention

Connection Name:

Select a database manager:

Cloudscape

DEZ for I5/035

IDBC driver: ‘IMS Universal JDBC Driver Default

DB for Linu, UNIX, and Windows
DBZ for 205

Derby Properties
Generic JDBC —
EOL0E General

Tracing | Optional

1>

Informix *Cannection name: | IM5 DB
i Data store: |
MySQL
oracle B
SQL Server [ ipaddress
Sybase *port number: [ porthium
websphera

User name: I

Password: |

[]5ave password

Default schema: |

Metadata source

Explorer).
M5 Catalog

The IMS Universal JDBC driver uses this information to process SQL calls to IMS, Select a
PSB or specify a Java metadata class {generated by the DLIModel Utiity plug-in or 1M5

O e I

Local IMS Explorer project

@ Pkt [

peg: |

Local file system

(¢} File location:

Browse. ..

et adata clace:

@

[£3

Cancel
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@ New Connection ‘;‘@@

Connection Parameters

Select the database manager, JDBC driver, and required connection parameters.|

Connection identification
Use default: naming convention

Connection Mame:

Select a database manager:

Cloudscape ) : v
o IJDBC driver: | M5 Universal JDBC Driver Default | A

|DBZ Far Linux, UNIE, and Windows

DEZ for 205

| Derby Properties
Generic JDBC

HS;LDE General | Tracing | Optional

*Connection name: | IMPOTxx

Informix
|MaxDE Data store:
|yl IM3E
g(rgaLdSerar *Host: zserveras,demas.ibm, com
Sybase *Pork number: 7013
‘wWebsphere
User name: IMPOTIO
Password: | seesssee
[Jsave passward

Default schema: [

Metadata source

The IMS Universal JDBC driver uses this information to process SQL calls ko IMS, Select a
PSE or specify a Java metadata class (generated by the DUIModel utility plug-in or M5
Explorer).

M3 Catalog
@ ps: | P1OSAMOS
Local IMS Explarer project
Praject:
(@) ¥
PSB:

Local file system

(o) File locatian:
|+
Test Connection e

@ wext> | [ Ensh | [ cancel

In the Connection Name field enter IMPOTxx where xx is your team number
In the Data Store field enter IMSB

In the HOST field enter zserveros.demos.ibm.com

In the Port number field enter 7013

In the userid field enter IMPOTxx where xx is your team number

In the password field enter IBMO7POT

Scroll down to IMS Catalog and select the radio button

Then enter PnnSAMO09 for your PSB value

Click Finish.

The connection is displayed in the Data Source Explorer.
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To test the connection in the Data Source Explorer section under Database Connections, right

click on your IMPOTxx connection.

Expand the path to tables and select PARTROOQOT.

2 MS Explorer - IBM Rational Developer for System z with Java |'._|[PE|E|
File Edit Mavigate Search Project Run  indow Help

L':dj o % T '5 9;' T : e ﬁ |Q IMM5 Explorer |
F@Project Explorer &3 = <}==(> pr e ()
=gt labzp195aMog =
1. TS | Inivare al Mwivare Makadaba .
s | 23
m Data Source Explorer 3 =0

il

EE M| E @ med B
E4 Derby Sample Connection
=4 MPoTxx
= [ PO
=[] Catalogs
= [ P1osAMOg
-7 schemas
=5 pcem
] Dependencies —
[ Sequences
[C) Stored Procedures
=07 Tables
[ BACKORDR
E cvccount

¢
T ¥ Drop

Edit
Load. ..
12890 A A Fa Crearvici Pisaranm Fvteark

Right click, select Data then click on return all rows to return data.

= [ml

7. The next exercise is to access the IMS Catalog to obtain the metadata that was generated

earlier.

Click on File > New > IMS Explorer Project
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@ Ius Explorer - IBM Rational Developer for System z with Java

GIEN Edit Mavigate Search Project Run Window Help

Attt PR er Project

Open Fle... £ Project...

@ Program Specification Block (P36}
£ Example..,

[ other... i+

& Refresh F5
Convert Line Delmiters To 4

lprope 2 9emor B protle| Dsqr| =0

4

Switch Workspace 4

Restart
Properties are not avalzble.
£y Inpart...

oy Expart..,
Properties Ale+Enter

1 zserverosdemasibmeom.hee: [HostCanne.. ]
2 5QLealls.sql [playimsexplarer]

3 DFSIVP37DakabaseView java [playimse...]
4 updScript12.sql [RemateSystemsTempF...]

Enter a new Project Name, e.g., Lab2DFSSAMO09.
€ New IMS Explorer Project |:|®

Create a new IMS Explorer project

Enter a praject name.

*Project name: | | AEZDFSSAMOY) |

@ < Back Mext = ] [ Finish ] [ Cancel

Select Next to specify the IMS Catalog as the import source.



€ New IMS Explorer Project

Select an Import Source
I N\

Import Fram:
) Local file system

Prerequisite: Before wou can import IMS resources, wou must copy the files From
wour 2/05 environment to your local workstation by using FTP,

() 2/05 system

Prerequisite: Befare vou can impart IMS resources, wou must have access to a PDS
file in wour 205 system,

(3) IM3 catalog

Prerequisite: Before vou can import IMS resources from an IMS catalog-enabled
syskem, you must create an IMS connection profile For that system,

@ < Back ” Mext = H Finish l[ Cancel

Select Next to import the PSB metadata.

& New IMS Explorer Project

Select Resources from IMS Catalog

PSE (program specification block)
PSEs bo impork:

PSE Marme Path

DED {database description)
DEDs ko impork:

@ Finish ] [ Cancel

Click Add PSB.



You will be asked to specify your connection profile. Specify IMPOTxx where xx is your

team number.

e Import IMS Resources (DBDs and PSBs) : E\E|

Select Resources from IMS Catalog

M5 Connertion Profile

Select the profile that contains the resources to impart,

Profile: | ccelect Canection Profiles
IMS DB part1

Resour el

<Select Connection Profile

Available FIES TompOTTY

PSEs to import:

N\

=4

@

Cancel

A list of resources from the IMS Catalog will appear. Use PSB DFSSAMO09 and DBD

DI21PART.

< Import IMS Resources (DBDs and PSBs)

Select Resources from IMS Catalog

IMS Connection Profile
Select the profile that contains the resources ta import,

Profile: | poTie v

Resources ko Import

Awailable P5Es to import: PSBs to import:

N

=

— i
|L|® G Import IMS Resources (DBDs and PSBs)

Select Resources from IMS Catalog

M3 Connection Profile
Select the profile that contains the resources to import,

Prafile: | papaiTys: “

Resources to Impark

Available DBDs to import: DEDs= ko import:

DFSIVPT ~ DF35AMO9 CELDCUSR A E'_.D"IIQIPART
DFSIVPE 0 CELDPROD T
DFSIVP9 CELDPROX
DF55AMOL CS04CA
DFSSAMOZ DEFSAMDL
DFSSAMOS DEFSAMDZ
DFSSAMD4 DEFSAMD
> >3
DF35AMOS - DEFSAMD4 -
DFSSAMOE DBIZT1
L £
DFSSAMOY e - DF3CO000 N -
DF35AMOG DF3CX000
EMPDEZ
DSKEIHO EMPLDEZ
DSNEIPO IPCDE v
& E 5 X 3] ? 4 ?
@) Firiish ] [ Cancel @) Finish l ’ Cancel
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@ New IMS Explorer, Project

Select Resources from IMS Catalog

PSE {program specification block)
P3Es to import:

PSE Mare: Path Add PSB...
DFSSAMO9
Dielete PSB
A ¥
DEBD {database description)
DBD's to import:
DED Mame Referencing PSE or DED Path
DIZ1PART
Delete DBD
A ¥

®

Select Finish.

Follow the path lab2DFSSAM09> DBD Source >Generated Source> IMS Catalog-enabled

File Edit Mavigate Search Project Run Window Help

1 i = Bi-idiy-iBWiH-H-
[ Project Explorer 22 B E &7 ° 0| Eeepenes

& lab2p1asamos
= [ lab2xDF55AMOg
(# 1M3 Universal Drivers Metadata
[+, IRE System Library [idk]
o imsudb.jar - C\Proaram FlesiBMSDRL
4 oeD
= Eﬁ DED Source
= Qj Generated Source
[=-(Z IM3 catalog-enabled DED source files
|=l DIZIPART
|= DIZIPART
g psa
) Eﬁ PSE Source
2] E prxsamid
1= SCLMConfigProject

o 5 | () s Explorer |

DATEEXIT=NO,
ENCODING=Cpl047

DATASET DD1=DIZ1PART,
DEVICE=3350,
OYFLW=DIZ1PARO,
BLOCK={0,0j,

SIZE= (0},
RECORD= { 678]

SEGH NAME=PARTROOT,
EXTERMALNAME=PARTROOT,
PARENT=0,

BYTES=50,
RULES={LLL, LAST),
ENCODING=Cpl1047

FIELD NAME= (PARTKEY,SEQ, V),

EZTERMALNAME=FARTEEY,

BYTES=17,
£ | > START=1,
= TYPE=C,
¥ Data Source Explorer 3@_ 8 T
e M| madg BT DFSMARSH ENCODING=Cpl047,
4 Derby Sample Connection - INTERMALTYPECONVERTER=CHAR
= a] IMPOTxx SEGM MNAME=STANINFO,
=] D IMPOTxx EXTERMALNAME=3TANINFO,
=7 Catalogs PARENT=P LRTROOT,
2 [J piosamoe BYTES=85,
=] Schemas ROLE3=(LLL, LAST),
=88 paant ENCODING=Cp1047
@ (L Dependencies FIELD MNAME= (STANEEY,3EQ, U],
D SEquenCes v FEYTFRWMATMIMF==TiNEF |
() Stored Procedures
3 B S = Properti Q—‘ Error Lo [:J Problem | = S0LRes 52 ,AE Remote }E Remake
2 mo
wiritable Insert 14126
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You can now also create SQL scripts in this project.

In the Project Explorer box, select your project e.g., lab2DFSSAMO09
Right click New > Other

2 ms Explorer - IBM Rational Developer for System z with Java

File Edit Mavigate Search Project Run ‘Window Help
- L REHI o A i g2 ﬁloIMS Explarer |
[T Project Explorer 53 =l Q:D E -0

i
&) labzp195amog
=] @ a In}

1

: [ Project...
E IMS Uriivers Go Into |
B IRE Systenm j File
=
Eé«; imsudb. jar Show In Alt+Shifc+w P (4 Folder
DEC
EE] DED Saurce 5] Copy Sing B SQkle
% PSE 152 Copy Qualified Name & Annotation
-
1% ps@ saurce) [ Paste Chrley @ Class
[ selectscript 3¢ Delete Delete @ e
& procsamos Bulld Path 3 & Interface
[ SAMConfiofrs)  pefactor AltbshiT b
Y Package
£ Impart. ., & Source Folder =
R R = (ml
18 pata Source Explord 1 Export... & HHrem | Hrem
[ Example... N
= G | &) Refresh F5 | " - X% BB |F
(= Database Conr Close Praject -
E4 BIRT Classil Close Unrelated Projects Operation Dz ™
E2 Derby Samy & : eec Return AllR.., Jdl
) mpoTee | 55 Transtorm eec SELECTPCB... Jul
IMsDBpar|  oidate eec INSERTINT..,  Jul
= ODAData Sour| oW In Remate Systems view eec SELECT PCB... Ml
(= ClassicMad ~ Software Analyzer Poeec Retun AR, JUl
[= Flat File Dal  Add 5QLJ Support... 1 5
= Run As 3
e @ lahz Debug As 3

In the Select a Wizard box expand the Data folder and select SQL or XQuery
Script then click Next.

B New

- B

Creates a new SOL or KQuery scripk |

Select a wizard

‘Wizards:

(= Business Inteligence and Reporting Taols A
(= CARMA
(= CIC5 Resources
(= COBOL
(= Connection Profiles
= vs
== Data
@ Data Design Project
ﬂj Data Development Project
[ Existing RAD 6.x Data Definition Project
EE Physical Data Model
201 Stoved Procedre ¥
[ show &ll Wizards.

@)

Caneel




Select a wizard

Creates a new SOL or BQuery script |

‘Wizards:

[ Connection Profiles ~
= oS
(= Data
tnﬁ [rata Design Project
ﬂ:l Data Development Project
[ Existing RAD 6.x Data Definition Project
EE Physical Data Model
sal SOL or XQuery Script
£0 stored Procedure
§§ User-Defined Function
§3 WehSphere MO User-Defined Function
(= 56L] Applications
[ [7% Frlinse Madelinn Framewnrk
[shaw all Wizards.

3

You will see the New SQL or Xquery Script box change Name to SelectScripti.

@ New SQL or XQuery Script

Project, Script, and Tool

Select the project, name the script, and choose the tool to use to create it

Project: labzxDFSSAMOY -
Mame: | Scripkl |
Edit: using

()5QL and XQuery editor (For scripts that contain one o mare SQL and XQuery statements)

Statement type: |SELECT v]

@j [ Finish H Cancel ]

Choose your Project lab2nnDFSSAMO9 from the dropdown list. Under the radio
button SQL Query Builder note that you can choose your Statement type. The de-
fault is Select.
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€ New SOL or XQuery Script

Project, Script, and Tool

Select the project, name the script, and choose the tool to use bo create it.

Project: RemoteSystemsTempFiles L
Mame: | Scripel |
Edit using

(501 and ¥Query editor (For scripts that contain one or more SOL and XCuery statements)
(3501 Query Builder {far single SOL SELECT, INSERT, UPDATE, or DELETE statement)

Skakement Eype: | SELECT v

® [ Finish H Cancel ]

When you have changed the values, click Finish.

G New S0OL or XQuery Script

Project, Script, and Tool

Select the project, name the script, and choose the tool o use ko create it

Project: labzxDF55AMO9 L

Mame: | Selectscripkl

Edit using
()50l and ¥0uery editor (For scripts that contain one of more S0L and XQuery statements)
(#)50L Query Builder (for single SOL SELECT, INSERT, UPDATE, or DELETE statement)

Statement type: |SELECT v|

® Finish ] [ Cancel
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When you have chosen your Statement type, e.g. SELECT for a query, click Finish.
- EX)

& Select Connection Profile

Select Connection Profile

Select a connection profile From the list below or click the New, ., butkan to create & new connection profile,

Connections

4 BIRT Classic Models Sample Database Mew..,

{4 Derby Sample Connection

~ Propetkies

Property Yalue

MHame IMPOTxx

Description

Cakegory Database Connections

Database IMPOTax

JDBC Driver Class com.ibm.ims, jdbe, IMSDriver

Class Location C:\Program Files\IBMSDPYiblimsudb. jar
Connection URL jdbciims: ffzserveros,demos ibm.com: FO13/P10...
User ID IMPOTIO

@

You will need to select a connection profile for the database you want to access. Choose
the one you created earlier, e.g., IMPOTxx. Click Finish.

The SQL Query Builder Box opens up.
In the Add a table window right click and select Add Table.

w7 Q-id:d- & s B | () M5 Explorer |
r{j Project Explorer £2 = Qé) :‘:" ¥ = O[3 seripti.sal [3] QueryScriptl sql £2 =
& labzp193amas - SELECT *
=5} labzxprssamog FEON T
[ 1MS Universal Drivers Metadata hs
= TRE System Library [jdk]
@ imsudb jar - C:\Program Files\IBM S0P e
Qa, DED To add a table, right-click in this pane and use the pop-up menu,
Eﬁ DED Source
(3 psp
Eﬁ PSB Source =
E QueryScripkl.sgl ot
E Script1.sql A _
[ selectseript1.sal k ‘ Columns | Conditions | Groups | Group Conditions
& procsamna | T
1= SCLMConfigProject b’
E L 2 = [l
¥ Data Source Explorer 5% =g =l prop |9 Errar [Z probl ElsqL i B rem | 48 Rem
- 4
i,
R IR | =L
52 Database Connections ~ | Type query expression here | Status
2 BIRT Classic Models Sample Database Status Cperation De &
&4 Derby Sample Connection v Succeer Return AlR... Jul
=) MPOTxx v Succeer SELECT PCB.., Jul
(0 mPoTix v Succeec INSERT INT... Jul
) 15 D8 partt 1 V' Succeee SELECT PCB... Jul
(= [ DA Data Sources v Succesc Return AR, Jul o
(= Classic Models Inc. Sample Database ||| € | > a
o* Datahase t...,connected ]
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You will be able to choose which tables to add, and check which columns to include.

S mMs Explorer - lab2xDFS5AM09/QueryScript1.sgl - IBM Rational Developer for System z with Java
Fle Edt Mavigate Search Project Run SQL  ‘Window Help

Ci-HEE i Q-4 #- Aol : & | (M5 Explorer |
r[\jProject Explorer &2 = <;=={> ;'=:=> 7 = 0| [@ *querySeriptl.sgl 52 = m|
E labzP1954M09 A SELECT PART NO EDIT, REJECT CODE
= E labzxDFSSAMO9 FROM PCEO1.PARTROOT

(2 IM3 Universal Drivers Metadata
B JRE System Library [idk]
=
foe imsudb.jar - C:\Program Files\IBM|SDPIE

g pep — =
% ESES e PLRTROOT =
o
% FSE Source [ FILLO ] 3
[ queryscriptt.sql /| PART_NO_EDIT
/| REJECT_CODE

|4

B Scriptl.sql =
SelectSoriptl. sl
@ Add Table E] B REE:2] — || [JoisTineT

B pxsamod

= 5 pcant = SCLMCanfigPratect b
g] e =
E BACKORDR & Data Source Explarer 3% = H El prop |9 Error EA Probl | ElsqL E3 j{ﬁ Rem JE Rem
= T
- o
= cvccount B E(ES mdg B XK 2B 3
Table NamE] E = Datahase Connections_ P ‘ Type query expression here | Status | Resultl
% STANIKFO 2§49 BIRT Classic Madels Sample Databass (apache ||| Status Cperation B |t s
o STOKSTAT | BirtSample EETL S Skarting run
&4 Derby Sample Connection =, v’ Succeer SELECTPCE... Jul —' SELECT * FROM PCEOL.PARTROOT
Table dlias: | ‘ =& MPoTxx ' Succeec INSERT INT,,, 1 Runsuccessful
0 mMPoTxx v’ Succeec SELECT PCE.., Jul
IMS DB parkl 3 v Succeec Return Al R... Jul o
< | | 2 | 3 @ B2

Displayed 12 of 12 resulks: 12 succeed...erminated, 0 warning, 0 critical errar

Note how the script is built. When you are done, position your cursor to the upper box,
right click on the Select statement that was built and choose the Run SQL option.

The results can be viewed in the bottom box.

2 Ms Explorer - lab2xDFSSAMO9/QueryScript1.sql - IBM Rational Developer for System z with Java
File Edit Mavigate Search Project Rum SOL  Window Help

L=<j T %TJ Ef%] % o 4 9;' iy =T ﬁ|QIMS Explorer |
|.—|\jProject Explorer &3 = Q:;; }:0 ¥ = O|| [@) *queryScriptl sql &2 = [ml
E labzP193AM02 A SELECT PART MO EDIT, REJECT_CODE

= g labzxDFssaMos FROM PCEOL.PARTROOT

[ 1M3 Universal Drivers Metadata
B\ JRE System Library [jdk]
I; imsudb.jar - C:\Program Files\IEM SO b

g pep [ =
Eﬁ DBD Source PTG =
& ps
Eﬁ PSE Source O FLLo
i /| PART_MO_EDIT « n
B QueryScripkl . sgl
% | REJECT_CODE w
E Scripkl.sqgl = b
E SelectScriptl ., sql
= DISTIMNCT
@ pecxsamid O
1= SCLMConfigProiect b
El prop | €] Error |21 probl | Bl soL E3 R R =g
¥ pata source Explorer 22 =0 rop | 9] error [ prol & Hrem | BHrem
— —+, =
e x Bl
B% ¥ (< ud| B LI,
- Database Connections P | Type query expression here ‘ Skatus | Resultl
=54 BIRT Classic Models Sample Database (spache || Status Cperation D4 Return All Rows
1 BirtSample Skarting run
= Derby Sample Connection 5 v Succeec SELECTPCE... Jul — SELECT * FROM PCBOL.PARTROOT
= £ P
=) MPOTsx v Succeer INSERTINT,,, Iul  Runsuccessful
0 mMPOTxx v Succeet SELECT PCE... Jul
) 5 DB part1 - ¥’ Succeer Return AllR... Jul o
< I ¥y ||« | 3 @ >
e

i Displayed 12 of 12 results: 12 succeed...erminated, 0 warning, O critical error




Note that there are two tabs. One for Status and one for Results.

S IMs Explorer - lab2xDFS5AMO9/QueryScript1.sgl - IBM Rational Developer for System z with Java

Eile Edit Mavigate Search Project RBun 3QL  Window Help
L=<j & [ﬂ @ % = '5 Q;' o . LR e E’l@IMSExplorer |
[ Project Explorer 52 = <='|='g> = ¥ = 0O || [@) *Queryscript1 sql 52 = m
(&) 1ab2p19samoa 4| SELECT PART_NO_EDIT, REJECT_CODE
=G5} 1ab2xFssamns FROM PCEO1.PARTROOT
[ IMS Universal Drivers Metadata
B JRE System Library [jdk]
@i imsudb.jar - C:\Program Files\IEMYSDRYD
I oeD == .
EG CBD Source PARTROOT —
G pse
E@ PSE Source O FLLD
B : | PART_MNO_FDIT & =
QueryScriptl .sql
; | REIECT_CODE F
B Script1.sql = b
B SelectScriptl.sql
s S [ClorsTineT
I=F SCLMConfigProject b =
@) Eror 2 - =5
W8 Data Source Explorer 32 =5 = Prop |9 Error E_\. Probl | EElsqL &3 JE Rem JE Rem
—s —*, =~
.
EE (S wd BT X% B0 3
(= Database Connections » | Type query expression here | Skatus |Resultl
=54 BIRT Classic Models Sample Database (Apache Statu Operatian D & PART_MO_EDIT | FILLOD &
0 Birtsample 1 O1P30SAMO3 ... =
5 Derby Sample Connection E v/ Succest SELECT PCB... ol — g 33223225&1”8 MQ
=) MPOTxx ¥ Succeec INSERTINT.. Ju 3 poceniaern
| IMPoOTa: v’ Suceesr SELECT PCB... Jul [ 0Z1aM1MNGTE. .. v
IMS DE part1 - v Succesc Return AllR.., Jul o < | b
4 | ¥ < | L3 Total 70 records shown
:¢ Displayed 12 of 12 resulks: 12 succeed.. .erminated, 0 warning, O critical error

Other examples of how to use the SQL Query Builder can be found on pages 24 -32.

This completes the lab.



